Chapter 3

Assembling
Sequences in the
Timeline

Learning Objectives

After completing this chapter, you will be able to:

* Organize assets in the Project panel

* Create a new sequence based on the specifications of a clip
* View clips in the Source Monitor

* Set the Source In and Source Out points

* Add clips to a sequence

* Add clips using the Overlay and Insert edits

* Use the Toggle Sync Lock and Toggle Track Lock buttons

* Perform the three-point Overlay and Insert edits
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INTRODUCTION

In this chapter, you will learn how to view clips in the Source Monitor, assemble a sequence
by dragging clips in the Timeline panel, set markers, set the In and Out points, and perform
Overlay and Insert edits. You will also learn three-point editing with monitor controls.

TUTORIALS

Before you start the tutorials, you need to download the c03_premiere_cs6_tut.zip file from
www.cadcim.com. The path of the file is as follows: Textbooks > Animation and Visual Effects >
Adobe Premiere Pro > Adobe Premiere Pro CS6: A Tutorial Approach

Next, extract the contents of the zipped file to \Documents\Adobe Premiere Tutorials.

Tutorial 1

In this tutorial, you will import a video clip, organize multiple clips, set markers on them and
create a sequence. In addition, you will set the In and Out points in the Source Monitor and add
clips to the sequence. The output of the sequence at frame 00:00:09:00 is shown in Figure 3-1.
(Expected Time: 30 min)

Figure 3-1 The output of the sequence at frame 00:00:09:00

The following steps are required to complete this tutorial:

Create a new project.

Import video clips.

Organize video clips in the Project panel.
Create a new sequence.

View clips in the Source Monitor.

Set Markers.

Set the In and Out points in the Source Monitor.
Add clips.

Render the sequence.
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Creating a New Project

In this section, you will create a new project.

1.

2.

Start Premiere; the Welcome to Adobe Premiere Pro dialog box is displayed.
Choose the New Project button; the New Project dialog box is displayed.
In the General tab of the New Project dialog box, type chapter03 in the Name text box.

In the Location area, browse to |\Documents\Adobe Premiere Tutorials and choose the Select
Folder button.

Choose the Scratch Disks tab. In the Captured Video, Captured Audio, Video Previews,
and Audio Previews drop-down lists, select the Same as Project option.

Choose the OK button in the New Project dialog box; the New Sequence dialog box is
displayed. Also, the file is saved with the name chapter03.prproj.

Select the default preset settings displayed in the Available Presets area. Make sure that
the Sequence 01 name is displayed in the Sequence Name text box and choose the OK
button; the chapter03 file is displayed, as shown in Figure 3-2.
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Figure 3-2 The chapter03 file displayed
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Importing Video Clips

In this section, you will import video clips.

1.

2.

Press the CTRL+1I keys on the keyboard; the Import dialog box is displayed.

Browse to \Documents\Adobe Premiere Tutorials\Media\Video\Norway and then select the road
drive (1).AVI clip from it. Next, choose the Open button; the selected file is imported
and displayed in the Project panel.
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Next, you will import multiple media files.
Double-click on the empty area in the Project panel; the Import dialog box is displayed.

Browse to |Documents\Adobe Premiere Tutorials\Media\Video\Norway. Next, select all media
files and then holding the CTRL key, click on the road drive (1).AVI clip to deselect it.

Choose the Open button; all selected media files in the Norway folder are imported and
displayed in the Project panel, as shown in Figure 3-3.
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Figure 3-3 All clips in the Project panel

Organizing Video Clips in the Project Panel

In this section, you will organize video clips in the Project panel.

Choose the New Bin button at the bottom of the Project panel; a new bin with the .
name Bin01 is created in the Project panel. Modify its name to sea clips.

Select all sea clips in the Project panel by pressing the CTRL key and then drag them to
the sea clips bin; all selected files are moved into the sea clips bin.

Click on the empty area in the Project panel to deselect the files.

Create a new bin with the name road clips and move all road clips to it. All clips are
organized in the Project panel, as shown in Figure 3-4.
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Creating a New Sequence

In this section, you will create a new sequence based on the settings of your clips or footage

in the Project panel.

Figure 3-4 All clips arranged in bins in the
Project panel

1. Select water fall.AVI in the Project panel; the thumbnail preview of the clip and its speci-

fications are displayed on the top of the Project panel, as shown in Figure 3-5.

Figure 3-5 The thumbnail preview and settings of the

¥ Project: chapter03 ><| V= |

water fall.AVI

Mowie, 640 x 430 {1.0)
i 00:00:28:06, 30.00 fps
> 8000 Hz - 16-bit - Mano

chapter03.prproj 17 Items

—

selected clip
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2. Choose the New Item button at the bottom of the Project panel; a flyout is displayed.
Choose the Sequence option from the flyout; the New Sequence dialog box is E
displayed.

3. Accept the default settings in the Sequence Presets tab.

4. Choose the Tracks tab from the dialog box; all areas in this tab are displayed. In the Audio
area, select the Mono option from the Master drop-down list.

5. In the Sequence Name text box, make sure that the Sequence 02 is displayed, and then
choose the OK button; the Sequence 02 is displayed in the Timeline and Project panels.

Viewing Clips in the Source Monitor

In this section, you will view the imported clips in the Source Monitor.

1. Double-click on the sea.AVI clip in the Project panel; the clip is displayed in the Source
Monitor, as shown in Figure 3-6.

i[ Source: seaAVI | v | ><| Effect Controls | V= |

Resolution
Playhead !
Position gﬁttttgnngs
00:00:00:00 Ft |« H 00:00:21:16
Playhead - Infout
Time ruler —=— u Ll puration
Lot e L [ [ [ oh ] [ »T
Button
Wlark Out Editor
Gotoln
Insert
Step Back Goto Ot
Play-Stop Toggle (Space) Step Forward

Figure 3-6 The sea.AVI clip in the Source Monitor
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In the Source Monitor, you can preview the clip, control the playback of the clip, specify
edit points, trim the audio and video clip, and specify some more viewing options. In
other words, the Source Monitor allows you to preview the audio and video clip and decide
whether you need the entire footage or only a part of it to add to the Timeline panel.

2. Choose the Play-Stop Toggle button from the Source Monitor; the video clip starts
playing in the Source Monitor. Choose the Play-Stop Toggle button again to stop g
the video clip. You can also press the SPACEBAR key on the keyboard to play and
stop the video clip.

3. Choose the Step Forward or Step Back button to move the video clip one frame
forward or one frame backward, respectively. Alternatively, press the right arrow
key on the keyboard to move the video clip one frame forward and press the left
arrow key to move the video clip one frame backward.

Press the HOME key to move the Playhead to the beginning of the clip and press the END
key to move the Playhead to the end of the clip. If you want to play the clip forward, press
the L key. If you want to play the clip backward, press the J key and press the K key to
stop the clip. Press the SHIFT+L keys to play the clip forward in slow motion. Similarly,
press the SHIFT+] keys to play the clip backward in slow motion.

The total duration of the video clip is displayed on the top right of the time ruler. Also,
the current frame time is displayed on the top left of the time ruler, refer to Figure 3-6.

4. Drag the Playhead on the time ruler to set the current frame to another time.

5. Move the cursor over the end of the time navigator bar and drag it to zoom in the time ruler
to view it in more detail, refer to Figures 3-6 and 3-7.

00:00:00:00 [Ft |~ H A, 00:00:21:16

|55|| ] ||
Lt Jdeffa > [o[«][d] >4

Time navigator bar

Figure 3-7 The time navigator bar dragged

6. Move the cursor over the Playhead Position in the Source Monitor; the cursor changes
to a hand symbol, as shown in Figure 3-8. Next, click on the Playhead Position; it is
converted into an edit box, as shown in Figure 3-9. Now, type 00:00:03:00; the Playhead
moves to the specified frame, refer to Figure 3-10.

00:00:09:00. = A 00:00:21:16

F'_l._ Playhead Position B

Lt [[te o w]t ][] >4

Figure 3-8 The cursor changed into a hand symbol
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00:00:00:00 I B <, 00:00:21:16

[ [ [&]
Lt fie oot ][d] >4

Figure 3-9 The current time display changed to an edit box
00:00:03:00 [Ft |~ H <, 00:00:21:16

Lt (g o fm]][dm] >4

Figure 3-10 The Playhead moved to another frame

7. Enter +25 in the Playhead Position edit box; the Playhead moves 25 frames forward, at
00:00:03:25, refer to Figure 3-11. Similarly, type -30 in the Playhead Position edit box;
the Playhead moves 30 frames backward, at 00:00:02:25.

00:00:03:25 [Fi 1 v] H # A, 00:00:21:16

EEIESREES N R S
Figure 3-11 The CTI moved to +25 frames

8. Click on the down arrow next to the Source Monitor label, as shown in Figure 3-12; a
drop-down list is displayed with the names of all the recently opened clips in the Source

Monitor. .
i | Source: sea.AVI |'|_': ><| Effect Contr
Loz

Close

Close All

@ Source: sea.AVI

Source: water fall.AVI

Figure 3-12 Clicking the down arrow on the right
of the Source Monitor label

9. Select the required option from the drop-down list to reopen clip in the Source Monitor.

You can select the Close option to close the currently opened clip. You can also select the
Close All option to close all clips and clear the Source Monitor.

10. In the Project panel, select multiple video clips simultaneously using the SHIF T key. Next,
drag and drop them to the Source Monitor; the selected clips are listed in the drop-down
list at the top-left corner of the Source Monitor. Using this list, you can quickly switch to
the required clip and view it in the Source Monitor.

11. Click the down arrow on the right of the Select Zoom Level option; a drop-down list is
displayed, as shown in Figure 3-13. Now, select the required option to zoom the view of
the clip in the Source Monitor.
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O | o Select Zoom
10% Level
25%
50%
75%
100%
150%
200%
400%

Figure 3-13 Various zooming options in the
drop-down list

12. In the Source Monitor, choose the Settings button; a flyout is displayed. By default,

the Composite Video option is chosen in this flyout. Choose the Audio Waveform
option; the audio waveform of the video clip is displayed in the Source Monitor, as shown
in Figure 3-14.

#| Source: sea view (1).avi | v ><| Effect Controls -= (&

Figure 3-14 The audio waveform displayed in the Source Monitor

Setting Markers

In Premiere, you can set clip markers as well as sequence markers. In this section, you will set
the clip markers on the important frames in a video clip for further reference.

1.

2.

In the Project panel, double-click on sea view (1).AVI; it is displayed in the Source Monitor.

Press the L key; the clip starts playing in the Source Monitor. Now, press the K key at
00:00:03:03 frame. Alternatively, you can type 03:03 in the Playhead Position edit box
to jump to that frame, as shown in Figure 3-15.
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| Source: sea view (1).avi | | ><| Effect Contrals | V= |

* 00:00:03:03 (= 00:00:21:00 &
Figure 3-15 The view at 00:00:03:03 frame

3. Choose the Button Editor button from the lower right corner of the Source Monitor; the

Button Editor dialog box is displayed. Next, click-drag the Add Marker button to the
playback controls area and choose the OK button to close the dialog box. As a result, the
Marker button is added in the playback controls area of the Source Monitor. Choose the
Add Marker (M) button in the playback controls area of the Source Monitor; a clip marker
is set to that frame. Also, an icon is displayed above the time ruler, refer to Figure 3-16.

lcon

00:00:03:03 Ft | (Eﬁ e 4, 00:00:21:00
W

, m
Lt el ][ o [ |+t ][]

v 4

Figure 3-16 The icon displayed above the time ruler

/ Note
@ 1. To view the marker; you need to move the Playhead.

2. 10 show the marker in the Source Monitoy; choose the Settings button; a flyout is displayed.
Next, choose the Show Markers option from it.
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4. Again, press the L key to play the clip and press the K key at 00:00:12:17 frame; the clip
is paused.

5. Choose the Add Marker (M) button in the playback controls area of the Source Monitor.
6. Similarly, set the markers at 00:00:18:01 and 00:00:20:28 frames.

7. Move the cursor over the video clip in the Source Monitor. Next, press and hold the left
mouse button over the clip and drag the clip to the Video 1 track in the Timeline panel;
the markers are displayed on the track, as shown in Figure 3-17.

v =8| | Video 1 1-
o o, o P W
Figure 3-17 The markers displayed in the Video 1 track

Setting the In and Out Points in the Source Monitor

If you want to use only a part of the video clip in your sequence, then you need to trim that
part from the clip. The first frame of the trimmed clip is known as the In point and the last
frame of the trimmed clip is known as the Out point. In this section, you will set the In and
Out points in the Source Monitor to use a particular part of the clip in the sequence.

1. Make sure that the sea view (1).avi clip is opened in the Source Monitor. The markers
have already been set in the clip and displayed on the time ruler.

2. Press the L key; the clip starts playing in the Source Monitor. Next, press the K key at the
00:00:03:03 frame; the clip is paused.

3. Choose the Mark In button from the playback controls of the Source Monitor; an
icon similar to the open bracket is displayed on the time ruler to specify the In
point. You need to move the Playhead to view the icon.

, Note
@ 1o add Mark In button in playback controls of the Source Monitoy;, choose the Button Editor
= button from the lower right corner of the Source Monitor; the Button Editor dialog box is
displayed. Next, click-drag the Marker button in the playback controls area and choose the OK
button to close the dialog box.
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4. Choose the Go to Next Marker button; the CTI is moved to the next marker at -y
00:00:12:17 frame. Next, choose the Mark Out button; another icon is created
similar to the closed bracket on the time ruler to specify the Out point. The area
between the In and Out points is highlighted, as shown in Figure 3-18. Also, the = ¥
total duration of the trimmed clip (00:00:09:15) is displayed on the top right of
the time ruler, refer to Figure 3-18.
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Q Tip. Press the I or O key on the keyboard to set the In or Out point, respectively in the

Source Monator.

00:00:12:17 [Ffr__1v] B B 9, 00:00:09:15
g L g g
| . :

Lt J[def[a > [ ]+ ][]
EREENEN >

Figure 3-18 The trimmed clip highlighted

Choose the Play In to Out button to play the trimmed clip in the Source
Monitor. To play the trimmed clip in a loop, choose the Loop button and Lo S o
then choose the Play In to Out button. To move the Playhead to the In or
Out point, choose the Go to In or Go to Out button, respectively. i«

Q Tip. Press the Q key to move the Playhead to the In point and the W key to move it to the

Out point.

If you need to change the In or Out point, then move the Playhead to the required frame
and choose the Mark In or Mark Out button again. To remove the In point, press the
ALT key and choose the Mark In button. Similarly, to remove the Out point, press the
ALT key and choose the Mark Out button.

Adding Clips to the Sequence
Once you have viewed and trimmed the required part of the video clip by specifying the In
and Out points, you need to add the trimmed clip to the sequence.

1.

Make sure the clip is selected in the Timeline and then press by DELETE on the clip.
Next, make sure that the sea view (1).avi clip is opened in the Source Monitor. Also, the
In and Out points are set in the clip based on your requirement.

Move the cursor over the Source Monitor. Press and hold the left mouse button and drag
the clip from the Source Monitor to the Video 1 track in the Timeline panel. Next, release
the left mouse button at the beginning of the Timeline panel; the clip is placed in the
sequence. Also, it is displayed in the Program Monitor, refer to Figure 3-19. Since this
video clip has both audio and video components, the video is placed on the video track
and the audio is placed on the corresponding audio track.

In the Project panel, double-click on the road drive (5).AVI clip; it is displayed in the
Source Monitor, as shown in Figure 3-20.

Press the L key to play the clip and press the K key when the Playhead reaches to the
00:00:02:28 frame; it pauses at that frame.
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5. Choose the Mark In button at 00:00:02:28 frame;
played, which specifies the In point.

File Edit Project Clip Sequence Marker Title Window Help

an icon similar to open bracket is dis-
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&3 b Video2
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Figure 3-19 The clip placed in the sequence and displayed in the Program Monitor

i [ Source: road drive (5)-AV1 | v | | Effect Controls |

00:00:00:00 [FE I+ OB W

Q. 00:00:24:17

)

[t fa][>w]-t][R]a]

Livt [ oo [ @ =] 1 ][ = =] +

Figure 3-20 The road drive (5).AVI clip in the Sowrce Monitor

6. Again, press the L key to play the clip and press the K key when the Playhead reaches to
the 00:00:14:11 frame; the clip pauses at this frame.

7. Choose the Mark Out button at 00:00:14:11 frame; an icon similar to open bracket is

displayed, which specifies the Out point. Also, the

highlighted, which specifies the trimmed clip, refer to Figure 3-21. The total duration of

the trimmed clip is 00:00:11:14.

area between the In and Out points is

upuwLofur 10q 2anpoidas jou oq ‘Kdor uoyvnipazy

112 U0

POIMmmm 11

woo o

00:00:14:11 [Fi__v] @ B 2 00:00:11:14
— -t -
(At fafo]m][t][@]&][m][se] >4

Figure 3-21 The highlighted trimmed clip
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@ By default, the Snap button available on the top left of the Timeline is chosen. As a '3'{

10.

11.

Next, you need to add this clip just after the first clip in the Timeline panel.

Move the cursor over the clip in the Source Monitor. Press and hold the left mouse button
and drag the clip from the Source Monitor to the Timeline panel just after the first clip.
When you drag the clip, its edges snap to the first clip. Also, its edges get aligned with
that of the first clip, refer to Figure 3-22. Next, release the left mouse button; the second
clip is placed just after the first clip in the sequence.

T 2 » Video 2

= 2 w Video 1
i o,

AL | a2 » Audio 1

13| |» Audioz
Figure 3-22 The second clip placed next to the first clip

Note
result, the snap feature will be available. You can deactivate this button to make the snap
feature unavailable.

When you drag the video clip from the Source Monitor to the Timeline for assembling
a sequence, the video and audio get linked together and both will be displayed on the
corresponding tracks. If you need to add only the video or the audio to the sequence, you
need to follow the steps given below.

To add only the video of the clip, move the cursor over the Drag Video Only button
in the Source Monitor and drag it to the Timeline on the video track. Only the
video of the clip is added to the sequence.

To add only the audio of the clip, move the cursor over the Drag Audio Only button ',
in the Source Monitor and drag it to the Timeline on the audio track. Only the audio

of the clip is added to the sequence.

Press CTRL+S to save the file.

Rendering the Sequence

In this section, you will render the sequence.

1.

Make sure the Timeline panel is active. Next, press the HOME key to move the CT1T to
the beginning of the sequence.

Press the ENTER key; a message box is displayed showing the progress of rendering. On
completion of the rendering process, the message box will disappear and the output will

be displayed in the Program Monitor.

The output of the sequence displayed at frame 00:00:09:00 is shown in Figure 3-23.
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Figure 3-23 The output of the sequence at frame 00:00:09:00

Tutorial 2

In this tutorial, you will add clips over the existing clips or between the clips in a sequence
using the Overlay and Insert edits. Also, you will protect one or more tracks from being moved
during insert edits using the Toggle Sync Lock and Toggle Track Lock buttons. The output
of the sequence at a frame is shown in Figure 3-24. (Expected Time: 20 min)

Figure 3-24 The output of the sequence at a frame

The following steps are required to complete this tutorial:

WO WIIPDI MMM, 11S12 UOUDUWLLOJUL 40, *2Inpo.das jou o “Cdor) uoyypnivay

Open the project.

Perform the Overlay Edit.

Perform the Insert Edit.

Protects tracks by using the Toggle Sync Lock and Toggle Track Lock buttons.

a0 oW
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Opening the Project

In this section, you will open the project.

1.

First, open the chapter03_overlay_insert_edits.prproj file that you have downloaded from the
CADCIM website. Two clips are already placed in the sequence.

Choose File > Save As from the menu bar; the Save Project dialog box is displayed. Browse
to \Documents\Adobe Premiere Tutorials. Type chapter03_overlay_insert_2 in the File name
text box and choose the Save button; the opened file is saved with the specified name.

Performing the Overlay Edit

In the Overlay edit, the new clip overlaps the existing clips in the Timeline, without shifting
the frames in the tracks. Also, the Overlay edit does not change the total duration of the
sequence. However, it changes the duration of any clip in the Timeline, if it gets overlapped
by the new clip. In this section, you will perform the Overlay edit.

1.

In the Project panel, double-click on the road side view (3).AVI clip; it is displayed in
the Source Monitor.

Set the In and Out points, as discussed in Tutorial 1.

Press and hold the left mouse button over the Source Monitor and drag the clip to the track
in the Timeline to the edit point of the first and second clips, which are already placed
in the Timeline, refer to Figure 3-25. Note that while dragging the clip to the Timeline,
the Program Monitor displays the current duration and view of the first and second clips,
as shown in Figure 3-26. Next, release the left mouse button; the new clip is placed in
the Timeline. Also, the duration of the first and second clips is reduced according to the
overlapping area. However, the total duration of the sequence is not changed.

i Sequence 01 ><|

00:00:00;00 F 0;00 00;00;04;00 00;00¢08;00 00;00;12;00 00;00;
g:@. IIIIIIIIIIIIII1IIIIIIIIIIIIIIIIIII

-

=@ |» Video 3

&= |» videa2

®@| v video1 |Seaview (i).avi[V] Opacity:0pacity ~ Opacity:Opacity -

Lol —

i3 |» Audio1 ™

B > Audioz ™

i3 v Audios ™

iB ¥ Audio4 *|seaview (1)avi[A] Volume:Level - Volume:Level -
Al | = AN, SV O e e e
e &, P e

P e ) e | |

Figure 3-25 The road side view (3).avi clip dragged to the edit point of the first and second clips
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i[ Program: Sequence 01 | ¥ | ><| ~= (2

00:00:11:08 00:00:05:27

{ 00;00;08;07 Fit | v 00;00;12;08 »
Figure 3-26 The current duration of the first and second clips in the Program Monitor

4. Press CI'RL+Z to undo the last step. Now, you will perform the Insert Edit.

Performing the Insert Edit

In the Insert edit, the new clip shifts the already placed clips on the track to make room for
itself. Also, the Insert edit changes the total duration of the sequence but it does not change
the duration of any clip in the Timeline. In this section, you will perform the Insert edit.

1. In the Project panel, double-click on the road drive (5).AVI clip; the clip opens in the
Source Monitor.

2. Set the In and Out points, as discussed earlier.

3. Press and hold the left mouse button over the Source Monitor and drag the clip between
the first and second clips in the Timeline; the shape of the cursor changes, as shown in
Figure 3-27. Next, press the CTRL key; a vertical line is displayed with forward arrows
on it, as shown in Figure 3-28. These arrows indicate the direction in which the clips will
be shifted in the Timeline panel. Now, release the left mouse button; all clips after the
insertion point shift forward to make room for the new clip. Also, the new clip is placed
between the first and second clips, refer to Figure 3-29. Note that the total duration of
the sequence increases in this process.
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00;00;04;00  00;00;08;00 :00;12; -00; 16 00;00;20;00  C
1IIIIIIIIIIIIII L1l

A AN
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Figure 3-27 The changed shape of the cursor after placing the
cursor between the clips

sea view (1).avi [V] 'pacity:Opacity .‘

Figure 3-28 The vertical line with forward arrows

& @ v Video1 |Seaview (1).avi[V] 'pacity:Opacity ~ || road drive (5).AVI[V] ty v |sea view.AVI [V] Dpacity:Opacity -
. J |- o _ el
g o

12 » Audio1 ™

i3] > Audio2 ™

2| > Audioz ™

Al

B ¥ Audio 4 | sea view (1).avi [A] Volume:Level ~ || road drive (5).AVI[A] el ~|sea view.AVI [A] Volume:Level ~
N TR e || TRRY T T —
) = KR Ul s A R

Figure 3-29 The new clip placed between the two clips

Press the SPACEBAR key to view the sequence; the clip starts playing in the Program
Monitor.

You can also split an existing clip by using the new clips. To do so, you need to follow the
steps given below:

In the Project panel, double-click on the road drive (2).AVI clip; it is opened in the Source
Monitor.

Set the In and Out points, based on your requirement.

Press and hold the left mouse button over the Source Monitor and drag the clip in the
middle of the sea view.AVI clip in the Timeline panel. Next, press the CTRL key; a
vertical line is displayed with forward arrows on it, as shown in Figure 3-30. Next, release
the left mouse button; the sea view.AVI clip is split into two parts and the second part is
shifted forward in the Timeline panel. Also, the new clip is placed in the middle of the
two parts, refer to Figure 3-31.
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Figure 3-30 The cursor in the middle of the sea view.AVI clip
saa:i-e:fﬂ\l’ll\a Load drilvejg!JWIIVI | sea viewAVI[V] -

sea view. AVI [A

road drive (ZLAVI[A] +|sea viewAVI[A] -
i Ll ot adie L

Figure 3-31 Partial view of the track afier placing
the new clip in the middle of the sea view.AVI clip

8. Press the SPACEBAR key to view the sequence; the clip starts playing in the Program
Monitor.

Protecting Tracks by Using the Toggle Sync Lock and Toggle
Track Lock Buttons

In a typical video editing project, you may have multiple tracks of video and audio clips in the
Timeline. While performing the Insert or Ripple edits, if one track shifts, all other tracks will
also shift. However, sometimes you do not want to shift a particular track. In such a case, you
can protect one or more tracks from being moved by using the Toggle Sync Lock and Toggle
Track Lock buttons. In this section, you will use these buttons to protect tracks.

1. In the Project panel, double-click on the water fall.AVI clip; the clip opens in the Source
Monitor.

2. Set the In and Out points, based on your requirement.
3. Move the cursor over the Drag Video Only button in the Source Monitor and drag ﬁ

it to the Timeline in the Video 2 track; the video portion of the clip is displayed
on the Video 2 track, as shown in Figure 3-32.
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Figure 3-32 Video 1 and Video 2 tracks

Expand the Video 2 track by choosing the Collapse-Expand Track button in the »
Timeline, refer to Figure 3-32.

Next, you need to insert a new clip in the Video 1 track in such a way that the clip in the
Video 2 track is not affected by the Insert edit.

In the Project panel, double-click on the sea view (2).AVI clip; the clip opens in the Source
Monitor.

Set the In and Out points, based on your requirement.

In the Video 2 track, choose the Toggle Sync Lock button; the button gets =5
deactivated.

Move the cursor over the Drag Video Only button in the Source Monitor and drag it
to the Timeline in the Video 1 track in the middle of the sea view (1).AVI clip, refer to
Figure 3-33. Next, press the CTRL key; a vertical line is displayed with forward arrows on
it, refer to Figure 3-34. Next, release the left mouse button; the new clip shifts the other
clips forward in the Timeline and it is placed in the middle of the sea view (1).AVI clip
in the Video 1 track, refer to Figure 3-35. However, the clip in the Video 2 track is not
affected by the Insert edit.

=/ [ |¥ video 2 =
g o, :

: i 1).avi acity ~||road dri LAVI -
21 v video1 |S€8view (1).avi pacity - |/ra Tfe!é! vl ty
o

_
DR =
rF N u

Figure 3-33 The cursor in the middle of the sea view (1) clip in the Video 1 track

= B » Video 3

&/ || | video 2 fall.AVI M
e -
= 3 w Video 1 sea view (1).avi pacity -

I

road drive (5).AVI[V] ty =
v - [ -y
i o,
| I3 |» Audio1 ™

Figure 3-34 The vertical line with arrows displayed on pressing the CTRL key
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Figure 3-35 The new clip inserted in the Video 1 track

ea view |

9. In the Video 1 track, choose the Toggle Track Lock button; this button becomes El

available now. Also, diagonal lines are displayed in the Video 1 track, as shown in
Figure 3-36. Next, insert a new clip in the Video 1 track. You will notice that you
cannot perform any action in the Video 1 track as you had chosen button.

=2 | video 2
i e, :

=3 a ¥ video 1
i o, ]

Figure 3-36 Diagonal lines in the Video 1 track

10. Press CI'RL+S to save the file. Next, press the ENTER key to view the output of the
sequence in the Program Monitor. The output of the sequence at a frame is shown in
Figure 3-37.

Figure 3-37 The output of the sequence at a frame

Tutorial 3

In this tutorial, you will perform the Three-Point Overlay and Insert edits using the editing
buttons available in the Source Monitor. The output of the sequence at frame 00:00:09:12 is
shown in Figure 3-38.

(Expected Time: 20 min)
The following steps are required to complete this tutorial:

a. Open the project.
b. Perform the Three-Point Overlay and Insert Edits.
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Figure 3-38 The output of the sequence at frame 00:00:09:12

Opening the Project

In this section, you will open the project.

1.

First, open the chapter03_overlay_insert_edits.prproj file that you have downloaded from the
CADCIM website. Two clips are already placed in the sequence.

Choose File > Save As from the menu bar; the Save Project dialog box is displayed.
Browse to |Documents\Adobe Premiere Tutorials. Type the name chapter03_three_point_edit
in the File name text box and choose the Save button; the opened file is saved with the
specified name.

Performing the Three-Point Overlay and Insert Edits

In this section, you will perform the three-point Overlay and Insert edits.

1.

In the Project panel, double-click on the sea view (2).AVI clip; the clip opens in the Source
Monitor.

Set the In and Out points, based on your requirement.

In the Timeline panel, set the CTT at a position where you want to set the starting point
of the new clip, refer to Figure 3-39.

Choose the Button Editor button from the lower right corner of the Source
Monitor;the Button Editor dialog box is displayed. Next, click-drag the +
Overwrite button in the playback controls area and then choose the OK button
toclose the window.Next, choose the Overwrite button in the playback controls

area of the Source Monitor to perform the Overlay edit; the new clip is placed ==
in the sequence. Also, the CTT is moved to the end of the new clip, as shown in
Figure 3-40.
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Figure 3-39 The CTI set over the clip
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Figure 3-40 The CTI placed at the end of the new clip

Next, you will perform the Insert edit using the editing buttons.

5. Move the CTT to the end of the first clip and at the starting point of the second clip, refer

to Figure 3-41.

00:00:09;12

E”—‘v Video 1 24 vIEn
me B : _ -

iR ¥ Audio 4 !
SRS ] .

Figure 3-41 The CTI set in the Timeline
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6. In the Project panel, double-click on the sea.AVI clip; the clip opens in the Source Monitor.

7. Set the In and Out points, based on your requirement.

8. Choose the Insert button in the playback controls area of the Source Monitor; the
new clip is inserted, shifting the other clips forward in the Timeline, refer to [o)

Figure 3-42.
: Sequence 01 ><\
00:00:10:22 (00,00 00;00;04,00  00;00;08;00 ;00;12;00  00;00;16;00  00;00;2
8 | vide3
=3 |k video 2
o8 v video1 | seaview(1)avi[V] pacity:Opacity ~|sea.| sea viewAVI[V] | sea view (2).avi
v = — =
—
w8 [» Audior ™
B |» audioz ™
2 [» Audios ™!
4981 v audio4 * seaview(1)avi[A] Volume:Level - |sea.| sea view AVI[A] |sea view (2)avi
AL H la . T v
| Master *
Figure 3-42 The new clip inserted
Note

You can also press the period (.) key for performing the Overlay edit and the comma (,) key for
performing the Insert edit.

9. Press CTRL+S to save the file. Next, press the ENTER key to view the output of the
sequence in the Program Monitor. The output of the sequence at frame 00:00:09:12 is

shown in Figure 3-43.

Figure 3-43 The output of the sequence at frame 00:00:09:12
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Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1.

10.

Which of the following shortcut keys is used to invoke the Import dialog box?

(a)l (b) CTRL + 1
(¢) SHIFT + I (d) CTRL + SHIFT + I

Which of the following buttons is used to create a new bin in the Project panel?

(a) New Item (b) Icon view
(c) New Bin (d) None of these

Which of the following shortcut keys is used to perform the Overlay edit?

(a) Period (.) (b) Comma (,)
(1 (d) O

Which of the following shortcut keys is used to perform the Insert edit?

(a) Period (.) (b) Comma (,)

(@1 (d) O
The first frame of a trimmed clip is known as the point and the last frame of
the trimmed clip is known as the point.

You can remove the In points first pressing the ALT key and then choosing the
button.

To view the marker in the Source Monitor, you need to move the Playhead. (T/F)

The Drag Video Only button in the Source Monitor is used to add only the video of the
clip to the Timeline. (1/F)

In the Overlay edit, the new clip overlaps the already placed clips in the Timeline panel
and it shifts the frames in the tracks. (T/F)
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The Insert edit changes the total duration of the sequence, but it does not change the
duration of any clip in the Timeline. ('1/F)
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Review Questions

Answer the following questions:

1. Which of the following buttons is used to protect one or more tracks from being moved
while performing the Insert edit?
(a) Toggle Track Lock (b) Toggle Sync Lock
(c) Collapse-Expand Track (d) None of these
2. Which of the following buttons is used to collapse or expand the tracks in the Timeline?
(a) Toggle Track Lock (b) Toggle Sync Lock
(c) Collapse-Expand Track (d) All
3. Which of the following buttons in the Source Monitor is used to perform the Overlay
edit?
(a) Insert (b) Overwrite
(c) Set In Point (d) Set Out Point
4. In the Source Monitor, you can control playback, specify edit points, trim the audio and
video clip, and specify some more viewing options. (1/F)
5. The Overlay edit does not change the total duration of the sequence, but it changes the
duration of any clip in the Timeline. (1/F)
6. Press the key to move the clip forward. Press the key to move the clip
backward and press the key to pause the clip.
Exercise

Exercise 1

Create a new project in Premiere based on the settings of your video clip. Next, import the
video clips in the Project panel. Tiy to set the In and Out points of the clips in the Source
Monitor. Also, perform the Insert and Overlay edits using the shortcut keys.

Answers to Self-Evaluation Test
1.b,2.¢,3.a,4.b,5.1In, Out, 6. MarkIn, 7. T, 8. T, 9. F, 10. T



